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Introduction
1. This step-by-step training program includes and uses a model dataset. The models can be found on
Bricsys 24/7 under the project Bricsys Partner Area, under the folders Sales & Training tools >
BricsCAD Mechanical Training > v21.
2. For some of the exercises you will need the Communicator extension to import the models used.
This can be found on the Bricsys webpage under “Products”. If you do not have the Communicator
installed, you can open a previously imported file under the subfolder “Steps” of the relevant
exercise.
3. All of the exercises uses the metric unit mm unless; otherwise is specified, or if an imported
component uses another unit.
4. Be mindful of what selection modes you have active. We will be using: Select edges (1), Select faces
(2), Select detected boundaries (4).
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Direct modeling
1. Launch BricsCAD.
2. In the Launcher screen select the Mechanical workspace.

3. Create a new drawing: Click the small BricsCAD symbol in the top left of the start Screen -> New
wizard (NEWWIZ) -> Start from Template -> Mechanical-mm.dwt. Here you get more options for
starting a new file than you would by simply creating a new drawing.

4. Set up new values for some variables: SNAPTYPE=0 (snap to grid), SNAPMODE=1 (can also be
accessed on the statusbar), GRIDMODE=1, OrbitAutoTarget=1 (for rotation around center of the
current screen).
5. Switch current visual style to 2dWireframe using VISUALSTYLES command.
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6. Call Polyline command (PLINE) and draw a polyline contour, by snapping to the grid:
Start point (0,0,0) - second point (0,200,0) (1) - segment L=100 (2) snapping to the grid under 135° (3) - segment L=100 (4) snapping to the grid knot (5) - Use the “Close” dialogue option of polyline command (6).

7. Set SNAPMODE=0 and GRIDMODE=0, and set back VISUALSTYLES to “Mechanical”.
8. Activate the DMEXTRUDE command and extrude the sketch downwards by 20mm, and change the
color of the base to Green in the Properties panel.
9. For the next steps we will be sketching on the solid itself. Therefore you should have Dynamic UCS
active. It can be toggled with the F6 key, or click DUCS on the status bar in the bottom right of the
BricsCAD window. Now when the DUCS is active it will align with any surface you try to sketch on.
To temporarily lock on to the surface you want to sketch on, you can hover over the surface and
press the Shift key and you should see the surface become highlighted with a darker blue colour.
10. Activate the RECTANGLE command and create a rectangular contour 20mmx60mm, placed
centered against the back edge, as seen in the picture below. This is for a vertical stand so
DMEXTRUDE it upwards by 150mm.

4

11. Create CIRCLE on the vertical face. Snap to the midpoint of the edge, then snap on to the
corner of the edge. Then extrude it 130mm, perpendicularly away from the vertical stand.

12. Now the goal is to make a flush connection between the pillar and the cylinder. For this make sure
you have “Prioritize Selection of Faces” active. (SELECTIONMODES=2) Select the half circle face at
the back of the cylinder, and DMEXTRUDE the half circle to be flush with the back face as seen in
the picture below.

13. Turn on Design intent "coincident planes". You can use the command DMRECOGNIZE and set its
value as 2, or find the design intent settings on the ribbon under the Solid tab. This option will
recognize any coincident planes on the model. To test this, select the face on the front of the
cylinder. Then activate Push/Pull (DMPUSHPULL), and see how the model reacts to this. The
bottom of the model should also react to the changes made to the cylinder. Undo any changes
made to the geometry in this step before moving on.
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14. Hover over the circular face and choose the OFFSET tool from the Quad. Offset the
circle inwards by 10mm.

15. Hover over the circle and extrude a hole through the whole cylinder using DMEXTRUDE command.
16. Try turning on Design Intent "Coaxial surfaces" option. (DMRECOGNIZE = 34) Activate the DMMOVE
command and select the center of the cylinder hole. Try moving it up and down and see how the
cylinder and the hole share the same center while being moved.
If you are not able to move it as seen in the picture below, try holding the Shift key while the
command is active and while moving the hole. This way the movement will lock on to one of the 3
coordinate axes.
Undo any changes made to the geometry in this step before continuing.

17. Select the two vertical edges on the front of the base, as shown. Then create fillets by activating
DMFILLET. Give the fillets a radius of 25mm.
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18. The goal of this step is to create 2 holes on the base of the model, sharing the same
center as the fillets we just created. To secure this placement of the holes, check your
ESNAP settings. Right click ESNAP on the status bar in the bottom right of the screen.
There you should enable the Center option. You will know is enabled if there is a rectangle around
the symbol of the center snap option as seen below.

Now activate the CIRCLE command and hover over the top face of the base. Remember you can
press Shift to lock your sketch to this face. Now hover your cursor over the rounded edge of the
fillet and you should see the snapping point of its center show up. As seen below.

Now click to select the center as the base point of the circle. Give the circle a radius of 10mm.
Do the same for the other side of the base so you end up with 2 circles.
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19. Use the command DMEXTRUDE to create 2 holes from the circle sketches.

20. Select the circular top edges of the holes. Then activate the DMCHAMFER command to create
chamfers. Give the chamfers a distance of 5mm.

21. Draw a 50mmx20mm rectangular profile under the part's head, placed centered against the
vertical stand, as seen in the picture below. DMEXTRUDE the profile vertically but do not enter any
value. Instead, through the command line dialogue select the “Set Limit” option. Then select the
outer cylindrical face of the head as the limit. You should see the extrusion adapt to the shape of
the cylinder.
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22. Select the 2 large sides of the rib you just made. Activate the PUSH/PULL tool on the Rib,
and you will see that it still adjusts to the shape of the cylinder even if you change the
width of the rib.

23. Constraints: Apply DMFIX3D to the back face, a fixed constraint. Then place DMRADIUS3D to one
of the base's holes, a constraint to decide the radius of the hole. When placing the constraints,
accept the values that are suggested, do not type in any new values for the constraints.
Then turn on the Design intent "Equal radius" option. (DMRECOGNIZE = 98) The design intent will
allow the 2 small holes to share the same size as they share an equal radius. Meaning that if the
constraint that determines the hole size it will change the size of both holes.
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24. Create planar angle constraint with the DMANGLE3D command. Select the back face and
the front face of the rib. As seen in the picture below. When the angle is first placed it
might work in a different direction that we want. To ensure that it works in the correct
direction we can set a reference. In the command line dialogue, select the “Set Reference Entity”
option. Then select the horizontal edge at the back of the base, as seen in the picture below. With
this line as the reference it will orientate the direction of the angle constraint correctly. Then accept
the angle value as 180°.

25. Open the Mechanical browser panel. Find the angle constraint and change the value by 10° to
create an upwards incline as seen in the next step.
26. Select edges and activate the DMFILLET command to create fillets as seen below. Give the fillets a
radius of 3mm. You can do them one by one edge, or you can select them all at once. To help with
the selection you can hover over a face, and through the QUAD you can find different selection
options. Such as the one highlighted that allows for selection of all edges around the face.
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Surface Modeling
1. Create a new drawing: File-> New (QNEW).
2. Draw a RECTANGLE with the fillet option in the command line. Give the fillets a radius of 20mm.
After accepting the fillet value, type 0,0,0 and accept. This will start the rectangle in the origin point
of the drawing. Then give the rectangle a width of 200mm in the X direction, and 250mm in the Y
direction.
3. Draw a LINE, as shown between the endpoints of the radii. Then with boundary detection active
(SELECTIONMODES = 7), hover over the center of the sketch. From the QUAD create a region as
seen in the picture below, now you will have created a surface.

4. Hover over the region and extrude surface through the QUAD. Or use DMEXTRUDE, and in the
command dialogue set “Mode” to ‘’Surface’’ and extrude the outside edge upwards with a height of
60mm, and outwards with an angle of 40 degrees. To switch between the height and angle value,
use the Tab key on your keyboard.

5. Stitch two surfaces. Select all with Ctrl+A and call DMSTITCH. During this exercise the surfaces
should always stay as one surface, so if the model consists of several surfaces at a later stage, you
can use DMSTICH to combine them again.
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6. Select the base face and rotate it around the back edge by using DMROTATE. Then
complete the rotation by snapping it to the top corner as shown below.

7. Create POLYGON (center-side) with 4 sides and Size = 30.

8. DMEXTRUDE polygon with slice option (use the 3rd Ctrl modifier). Delete sliced piece of the surface.

9. Select the three edges as seen highlighted below. You can do this by manually selecting each edge,
or you can use a selection window.

10. Activate the DMEXTRUDE command on the 3 selected edges, use the command line option “set
direction” and then select the X-axis. Extrude it with a distance of 250mm to create a handle.
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11. Close the end of the handle. Select one of the vertical side edges and use DMEXTRUDE
with the surface option and snap it to the opposing edge as seen in the picture below.

12. Select all handle's faces and activate the command DMROTATE. Rotate the handle upward around
the back edge of the pan, with a value of 12 degrees.

13. Select all handle's edges and activate the DMFILLET command. Give the fillets a radius of 6mm.
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14. Select bottom face edges of the pan and activate the DMFILLET command. Give the fillets
a 25mm radius.

15. Now the Dustpan should still be consisting of one surface, if not use the DMSTITCH command to
make it so. Select the surface and activate the DMTHICKEN command, and give it a value of 2mm.
This will turn the surface into a thin-walled solid.
16. Open the Properties panel and change some of the settings for the model. Try changing the color
and transparency settings and see how the model is affected.
For example change the colour to green and the transparency to 50.
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3D Constraints
For this exercise download the entire folder through Bricsys 24/7, you will need to locate
the file in your local folder system to import it into BricsCAD.
1. Create a new drawing: File-> New (QNEW).
2. This exercise requires the “Communicator” extension. Type in the command LICENSEMANAGER
and control that you have the Communicator installed. If not, it can be downloaded from the
Bricsys webpage.
3. Import the file (IMPORT) 3_Support de Commande 841.step. If the model is not visible you might
have to Zoom Extents. (Double click middle mouse button, or find the option on the ribbon on the
Home tab under the Navigate section. The LookFrom tool can also be used)
It is found as Step_1.dwg in the folder Steps for this exercise.

4. Select the entire model and change its color to 61 in the properties panel.
If you are having troubles with this step your model might have been imported as a block
reference. Hover over your model and you should see in the QUAD if it is called a block reference
or not. If it is you can activate the EXPLODE command and apply it to the model. Then you will be
able to change the colour of the model.
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5. Before modifying this model it can be useful to remove certain features of it.
Hover over the largest radius on the model. Through the QUAD go to the “Select” tab
and select the “Same or Less Radius Fillets” option. Then all the radii should be selected,
and you can delete them.
Then hover over one of the “Depressions” of the model. Through the QUAD go to the “Select” tab
and select the “Depression” option. It should select the whole depression feature so you can delete
it. You might need to do this for each of the depression features, a total of 3 times.

6. Create distance constraint by activating the DMDISTANCE3D command. Apply it to the Bottom of
the model, then to the top of the base and give it a value of 15mm. This will control the base
Height.

7. Create two more distance constraints the same way. This time apply it to the other "walls" of the
model, as seen below. Change them to 15mm also.
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8. In the Mechanical browser panel, right click on the root node as seen below. Then select
the sub option "Add new parameter".

OR
After creating the parameter, select it. When it is selected you will get the ability to modify it at the
bottom of the Mechanical browser panel. Change its name to “T” and give it a value of 15mm.

Now we will control the previously created constraints with this Parameter. To do this select the
first Distance constraint in the Mechanical Browser. Then change its expression to “T” in the
bottom of the Mechanical browser. Repeat this for the rest of the Distance constraints. When
finished the Mechanical browser should look like the picture below.

Select the parameter and change its expression to 18 and see the model change. Then change it to
25 and see the model change. Undo these changes so they are back at 15mm before continuing to
the next steps.
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9. Create an angle constraint by activating the DMANGLE3D command. Apply it to the top
face of the base and to the angled face, as seen below. Accept the suggested value.

10. Change the angle of the newly created constraint to 120°. Pay attention to the holes on the angled
face, with the angle change the 2 holes will not be perpendicular to the face anymore. This should
be fixed.
11. Undo the changes, switch on the Design intent option of perpendicular faces and
cylinders. (DMRECOGNIZE = 24) and try to change angle again.
All Design intent options can be found on the ribbon under the Solid tab.
12. Create a radius constraint (DMRADIUS3D) for the horizontal circular hole as seen below and
activate the Design Intent for Equal radius. Try changing the value of the constraint.

13. Activate Design intent for Coaxial surfaces, and use the DMMOVE command on the center of one
of the holes. Try moving the holes up and down and see how they keep their shared center.
Remember to hold the Shift key to move it along a specific axis.
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Parameters
1. Open the rib_constr_no_param.dwg file.

2. Check that "Coincident planes" design intent is switched on (DMRECOGNIZE = 2).

3. Task 1: is the ability to change the thickness of each rib with one value.
4. Create a new parameter (right click on the root node in the Mechanical Browser and select "Add
new parameter"). Give it the name "w" and expression "20".

5. Change the expressions for "Distance_2", "Distance_3" and "Distance_4" to "w". You can select
multiple constraints at once by holding the Ctrl key on your keyboard, this way you can change the
value of all 3 constraints at once.

6. Change the expression of "W" to "40" (all ribs will be modified accordingly - check the opposite side
of the model also to ensure this).
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7. Task 2: changing the overall length of the part, while keeping the thickness of each rib
unchanged and maintaining equal distance between them.
8. Create a new parameter "d" with expression "Distance_1/3". By adding mathematical
symbols such as the “/” we can create formulas that will calculate the final expression for us.
9. Change the expressions for "Distance_5" and "Distance_6" to "d".
10. Change the expression for "Distance_7" to "(d-w)/2".

11. Change the expression for "Distance_1" to 500. Observe the result, on the opposite side of the part
also.

12. Right mouse button click on Distance_1 and choose “Animate” to check the correctness of the
constraint. This can be an easy way to control that constraints work and how they work.
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Assembly design
1. Before starting this exercise you need to download the entire folder “5_Assembly_design”
from the Bricsys 24/7 panel. Right click the folder and select Download.

To know where the files are downloaded, call the command SETTINGS. In this window open the
categories “Program options”>”Bricsys 24/7”. Under this category you will see the row “Cloud
download path”. Here is where the files will be downloaded and this is where we will be working
with the files from on this exercise.

Now open the Engine_assembly.dwg file, in the Mechanical browser you can see the
assembly structure with components, subassemblies and constraints.
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2. Switch to the Layout tab and insert 2 BOM tables (BMBOM) tables. One with the Top
configuration and one with the Bottom configuration. You can do this with the command
dialogue options of the BMBOM command. You can also access the command from the
ribbon under the Annotate tab.
The Bill of Materials is generated based on the models that are placed in the assembly, and the
information they contain. The top level table contains all the files placed in this file, while the
bottom level table contains all the top level files as well as the sub-files of the top level parts.
The following exercises will help highlight the difference between the tables.
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3. Switch back to model space. Hover over the cylinder block and call the hide tool with the
command BMHIDE, or through the QUAD as seen below. This way of hiding a component
will affect the visibility of it only, and will still be taken into account by commands such as
BMBOM and BMMASSPROP, etc.

4. Call the BMINSERT command and insert the “Connecting_rod_assembly.dwg” and
“Piston_assembly.dwg”.
Like mentioned in Step 1, you will be able to find the files in the folder where your Bricsys 24/7 files
are downloaded.
The goal is to place the inserted parts as seen in the picture below.
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5. Position inserted components with the help of 3D Constraints: concentricity and
coincident. The connecting rod should be placed 20mm away from the crankshaft
counterweight. This can be done by manually using the DMMOVE command, or you
can apply a DMDISTANCE3D with the value of 20.
In the picture below you can see the positioning of the components.

To align the piston and rod correctly you can use Parallel constraints (DMPARALLEL3D). As seen
below you can apply one parallel constraint between the faces of the rod, and one between the top
face of the piston head. Be sure to place these constraints to the other piston and rod that shares
the same crankshaft center position.
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6. Open the Connecting_rod.dwg subassembly. You can do this from the file browser or by
right clicking the part in the Mechanical browser and then clicking open.
As you will see when opening it is that there are no bolts here. So we will place them.

7. Open the Library panel and find:
ISO 4017 HEX Head SCR M10x1.5x40 (You can use the search field and type in 4017)

8. Click on the bolt in the Library panel and go to the Properties panel to change the parameters of
the bolt. We need M10x1.5x40. Underneath you can see where you will need to search for this bolt
size.
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9. Now when the sizing of the bolt is correct we can place it. In the command line dialogue,
Use the Multiple option. This way we can insert two bolts. Also to help the insertion of
the bolts we can hover over the face we want to place them, and press the Shift key to
lock on to the correct surface. And then we can snap on to the center of the holes to place the
bolts.

10. Save Connecting_rod_assembly.
11. Switch to the main assembly and update it by calling the BMUPDATE command. This should now
make sure that the newly saved file is updated in the main assembly. Check this by ensuring that
bolts are now seen in the main assembly.
12. Go to the library panel and search for BBRG-30. Click it and go to the properties panel. There
change its sizing to 40mm. Use the Multiple option to insert 2 bearings, one at each end of the
crankshaft.

13. Position bearings on the crankshaft by using 3D Constraints: Concentricity to place it on the shaft,
and Coincident with the face of the crankshaft support. Do this in each end for both bearings.
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14. Switch to Layout and check BOM tables. If the tables have not changed, call the command
BMUPDATE on the Entire model. Now you should see the bolts appear in the Bottom
level table only. And the bearings should appear in both tables. This goes back to the
explanation in Step 2.
To recap, the top level table contains all the files placed in this file, while the bottom level table
contains all the top level files as well as the sub-files of the top level parts.

15. Switch back to the model space.
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16. Hover over crankshaft and call the rotation tool DMROTATE.
Alternatively you can also use the manipulator for this, clicking and holding the crankshaft
for just over 0.25 seconds, or by selecting it and calling the command MANIPULATE.
Then you can use this tool to rotate the shaft.

17. If using DMROTATE, you need to pick a rotation axis. As a rotation axis choose the Y axis.
18. If using DMROTATE, pick any start point and rotate the model by using your cursor. This will show
the Inverse kinematic capabilities of constrained assemblies.
19. To improve the visual representation you can tune these settings to their respective values.
DRAGMODEHIDE=1 and DRAGMODEINTERRUPT=0.
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Assembly inverse kinematics
1. For this exercise, download the entire folder and work with the files from the local 24/7
folder where they are downloaded.
Create a new drawing: File-> New (QNEW).
2. Import Industrial-Robot_BTR.sat (IMPORT). If you do not have the Communicator installed you
can find the file already imported as a .dwg file. It is found as Step_1.dwg in the folder Steps for
this exercise.

3. Call DMSIMPLIFY to simplify imported geometry. This command removes unnecessary edges and
vertices, merges seam edges, etc. to clean up imported geometry. It is recommended to always run
this command on imported 3D solids.
4. Manually "explode" the assembly with the help of the DMMOVE command. Just to separate the
parts.
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5. Paint solids in different colors by selecting them one by one and altering the colour in the
properties panel.

6. Use the command BMFORM with the Local option in the command line dialogue. Name the pieces,
from bottom to top:
Base (Grey), Platform (Pink), Shoulder (Blue), Arm (Green), Hand (Yellow), Head (Cyan), Grip (Red).
Then your Mechanical browser should look like in the picture below.

7. Create assembly constraints DMFIX3D for the Base, DMCOINCIDENT3D and DMCONCENTRIC3D
to put together the assembly as it was when imported.
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8. Rotate (DMROTATE/Manipulator) the Platform and Shoulder. If some parts of the
mechanism starts to "jump" or move unexpectedly, go through every constraint property
and check the direction property.
The Directions property specifies whether the directions of the constraint arguments
are Same or Opposite. Changing from one to another results flips constrained entities with respect
to each other, it might resolve any issues with the inverse kinematics. If not try deleting constraints
that cause issues and replace them.

9. Insert (BMINSERT) the door component and position it with the help of 3D Constraints. The door
needs to be downloaded from the 24/7 panel and inserted from the download path folder. (similar
to previous assembly exercises)

10. Try inverse kinematics by using the commands DMMOVE/DMROTATE/Manipulator.
11. Switch the Hand component to external with BMEXTERNALIZE or by doing as in the picture below.
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12. Open the Hand and change its length with the help of DMEXTRUDE. Remember to save
the file after editing it.

13. Switch back to the assembly and call BMUPDATE to see the result.

32

Parametric components
1. For this exercise, download the entire folder and work with the files from the local 24/7
folder where they are downloaded.
Open the support_2.dwg file.

2. Switch to layout and check views/sections.

3. Open holeEdge_2.dwg. This file needs to be downloaded and later inserted from the local 24/7
download folder.
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4. Observe the BC_SUBTRACT and BC_UNITE layers. By naming the layers in this way it
allows geometry on this layer to modify existing pieces when inserted. The Unite layer
will add material to the solid it is inserted on, while the Subtract layer will remove
material from the solid it is inserted on. You will see this in action later in the exercise.

5. Change Diameter ½ -> ¼ Depth 1 -> 1.2 _edgeAngle 45° -> 55°.

6. Switch to Support_2 model and insert (BMINSERT) holeEdge_2.dwg, 3 times with the snapping to
the neighbor arcs. Remember to check your ESNAP settings and enable snapping to Center. While
placing the file you can also hold Shift and Right click to enable this snapping setting. Below you
can see where to place them.

7. Switch off visibility for the “BC_SUBTRACT” and “BC_UNITE” layers in the layers panel (click lightbulb
for each layer) and examine the model and its drawing.
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8. Select the pair of just inserted holes in the Mechanical browser, go to the Properties panel
and change PROPERTIES D = 12.7 -> 7 and Depth = 1 -> 0.8.

9. Examine changed drawing (the holes geometry has changed).
10. Open rib.dwg and add it to the Library panel (CREATELIBRARYBLOCK). Specify the name: Rib and
the folder: DEMO.

11. Switch to the support_2 model and click on the rib component in the Library panel to initiate
insertion.
12. Make sure Dynamic UCS is switched on (F6 hotkey).
13. Hover over the face of the cylinder and place the rib with the snapping to quadrant of the circular
edge. (Check ESNAP settings and enable Quadrant)
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14. Select just inserted Rib in the Mechanical Browser and Create a polar array
(ARRAYPOLAR) with 6 instances around the central hole.

15. Select the array in the Mechanical Browser and at the bottom of the panel, change the number of
array instances to 8.
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16. Change Rib's parameters: Angle=55, H=43.

17. Examine updated drawing.
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Drawing generation
1. Open the Valve.dwg file.

2. Go to the Annotate tab of the Ribbon and call Base View tool (VIEWBASE) for Entire model.

3. In the Layout1 create four base views (Front, Left, Right, Top) and one isometric view. After placing
the first base view you will be able to move your cursor to create the additional projected views.
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4. We can select one or several views and change their properties using Properties panel,
for example, we can disable/enable hidden and tangent lines.

5. Go to Annotate tab, select Full Section View type and create a full section (A-A) from the right base
view. As seen below.
You can use snapping on the drawing view for a more accurate result.

6. Create a half section (B-B) from the bottom base view.
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7. Create a section (C-C) of the connecting flange of the valve, as seen below. Create this
with the command line dialogue option “Depth”. Set the depth to 1 , accept and This
option allows you to place section view as normal, but while only including 1mm (in this
example) of the part following the section line.

8. Under the Annotate tab, create a "Rectangular" detail view D, as seen below, from the section A-A.

9. Under the Annotate tab create "Circular" detail view E, as seen below, from the section A-A.
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10. Create a "Circular" detail view F, as seen below, with the scale 2:1 from the section B-B.
You can change the scale by selecting the Detail view and finding the standard scales in
the Properties panel.

11. Open Section Style (VIEWSECTIONSTYLE), create a new style and name it "Custom section style".
Explore the settings and change the colour of the identifier, its position. Try to set up Arrows and
Hatch representation, line types of the section lines, the position of the end lines etc. Keep an eye
on the Preview window where you can see your changes previewed.

12. Open Detail Style (VIEWDETAILSTYLE), create a new style and name it "Custom detail style".
Explore the settings and change the colours of the identifier and boundary. Keep an eye on the
Preview window where you can see your changes previewed.
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13. Select any section views in the drawing and in the properties panel change its style to
“Custom Section Style”, which we recently created.

14. Select detail views and change its style in the properties to “Custom Detail Style”, which we
recently created.
15. Add the necessary dimensions to the drawing, as shown in the drawing below. Feel free to try
placing more dimensions of different varieties. When selecting a measurement that you have
placed, you can also add tolerances to it in the properties panel, feel free to give it a try.
16. Add Bill of Materials (BMBOM) as seen below. Through the command line dialogue, select
Configure, then the Material and Mass options. This will add these rows to the BOM table.

42

17. Open the BOM Manager panel. Remember that if you do not have this panel open or
docked, you can right click on the ribbon and find it through the sub option “Panels”.
18. The BOM Manager is where you can generate and edit your Bill of Materials. You can
add additional columns, apply filters, summarize values, and much more. Let us try to summarize
the amount of parts in this assembly now.

19. Right click on the Cell that says “Quantity”. In the option menu you will see “Footer”. Hover over
this and select “Sum”.

20. If you look at the bottom of the BOM table you should see it add a row that is called “TOTAL:”, and
at the bottom of the Quantity column the parts should be summarized to 14 total parts.
21. Repeat this with the Mass column as well, and you will see that the total weight of the assembly at
862,19 grams.
22. At the bottom of the BOM Manager panel you can see the Bill of materials properties. Change
the “Footer title” to “Sum:”.
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23. Pay attention to the BOM table that we placed in the Drawing space. It should update
automatically to reflect the changes made in the BOM Manager.

24. This is only scratching the surface of what is possible with the BOM Manager, but now you know
where you can generate and edit the Bill of Materials for your models.
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Sheet metal from scratch
1. Later in the exercise we will need to insert a block. Therefore be sure to download the entire folder
for this exercise so we ca insert the block from the local 24/7 download folder.
When downloaded, create a new drawing: File-> New (QNEW).
2. Draw a Rectangle (0,0,0) - (255,100,0).

3. Hover over rectangle and call Create Base Flange from the Quad menu (SMFLANGEBASE).

4. Hover over the front bottom edge of the base flange. Make sure you have enabled edge detection
for this. Also activate face detection for later in the exercise. Then build a new flange
(SMFLANGEEDGE) with a length of 13mm, and a 90° angle pointing downwards.
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5. Hover over the back top edge of the flange and build partial flange as seen below. To do
this activate the SMFLANGEEDGE command and select the Width option. The command
will ask for the offset width for the flange, so type in a 32mm gap on each side of the
flange. Then we can set the length and angle of the flange. The total length of the flange will be
62mm, with an angle of 90° pointing upwards.on the ribb

6. Create another flange from the one created in the last step. We want it pointing backwards, so
select the back edge of this flange. The flange will be 13mm long with an angle of 90°.

7. In the Mechanical Browser click on the root node and observe Sheet Metal properties at the bottom
part of the browser.
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8. View you model from an isometric view angle (so that we can easily observe changes
made to the model) and change the Thickness to 5mm. See the model change and undo
the changes to revert back to the original thickness.
9. Now change the Bend Ratio to 3. See how the model changes. Then undo this change.
10. Hover over the Little front Flange, call the Flange Rotate (SMFLANGEROTATE) command and
try to rotate the flange. This shows how the properties of the flange remain the same even if you
try to rotate it after its creation.

11. Hover over the vertical partial flange and use Push/Pull to see the behavior of sheet metal
flange feature. As you can see if you try to move a flange the thickness will be maintained.

12. On the Ribbon under the Sheet Metal tab and the Modify section. Select the Dissolve
(SMDISSOLVE) command. Apply it to the same vertical flange. The color of the flange will change
indicating that Flange feature has been dissolved. Try to Push/Pull the face as before. Now you will
see that when dissolved, the sheet metal features will not be maintained. Undo the changes made
in this step.
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13. Using the same method as before create two new flanges. Except this time select two
edges at the same time, to symmetrically create the edge flanges seen below.
Here is the length and angle of the flanges: L = 66; a = 90°.

14. Build two more side flanges symmetrically. With these dimensions: L = 25 a = 90°.

15. Build last 2 little horizontal flanges L = 15 a = 90°.
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16. Go to the Library panel and choose the Holes library.

17. Click on Slot, then change the default parameters to Diameter = 5, Length = 40 and place it on the
face like shown below. You might need to use the “Rotate component” dialogue option to get the
orientation right. Place it 30mm from the top edge and 12mm from the side edge, you will be able
to tab between these measurements while placing it on the face.

18. Mirror the hole symmetrically.

19. Switch off the “BC_SUBTRACT” layer. This will hide the red geometry of the slots.
20. Select all the short edges as shown below. The goal is to create chamfers. Give the edges in the first
picture a length of 5mm. Then do the same for the large chamfers in the second image, but with a
value of 50mm instead.
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21. Insert the holes2D.dwg block with the explode option. You can also explode it after
placement (EXPLODE). Make sure that this file has been downloaded so you can insert it
from your local 24/7 download folder. When inserted and exploded, DMEXTRUDE it to
create holes.

22. Hover over any flange in the model and call Unfold (SMUNFOLD) from the Quad.
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Sheet metal from solid
1. Create a new drawing: File-> New (QNEW).
2. Draw a Box (0,0,0) - (100,200,100).
3. Create a DMCHAMFER with size = 50, as seen below.

4. DMEXTRUDE front face L = 50.

5. DMROTATE horizontal face by a = 15°.
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6. Select the solid and use the Shell command from the QUAD, Ribbon, or the command
SOLIDEDIT with the sub options Body > Shell. Select the bottom face to remove it, and
set the wall thickness to 2mm.

7. Hover over the front inclined face and call the Offset (OFFSET) tool. Offset the face geometry
inward with a value of 10mm.

8. Select, or hover over the newly created rectangle and use the DMEXTRUDE tool to create a
rectangular hole. Extrude it with a depth of 2mm into the model, just to ensure that we extrude
through the wall of the shelled solid. But not far enough to affect the rest of the model.
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9. On the Ribbon under Sheet Metal in the Create section and call the Convert to Sheet
Metal tool (SMCONVERT), or use the same tool from the Quad.

OR

10. Go to the Ribbon under Sheet Metal in the Modify section and activate the Relief
(SMRELIEFCREATE) tool. The tool will cut small pieces of the solid body to avoid future material
conflict during bending operation. Apply it to the entire model.
However, keep in mind that in later versions of BricsCAD these bend reliefs will often be generated
automatically when applying other Sheet Metal features.
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11. Go to the Ribbon under Sheet Metal in the Modify section and activate the Junction
(SMJUNCTIONCREATE) tool. Apply it to 4 side edges (highlighted below) on both sides
of the model.

12. In the same location on the ribbon activate the Bend (SMBENDCREATE) command. Apply it to the
entire model. By applying it on the entire model, the command will detect any remaining hard
edges and place bends on these.
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13. Hover over the front inclined face and call Unfold (SMUNFOLD) command.

14. Place the unfolding near the initial model (use "Keep" option).
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15. In older versions of BricsCAD, Junctions in the Mechanical Browser might be painted in
red. These are warnings we need to fix. However, if you are running a later version of
BricsCAD and you do not have any errors, you can skip this step.
Zoom to Junction_1 and you'll see one of the arguments is too long and contact with more than one
flange feature. To fix this situation hover over the long side face and call Split (SMIMPRINT) tool. The
junction will be split into several junction features. Repeat the same procedure for another side of
the model.
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16. Let’s create a hypothetical situation, where the unfolding of this part is too large to fit on
the laser cutting machine in the workshop, and we need to optimize the space used. The
open window on our model wastes a lot of space and material, so we will change the
unfolding to make this space smaller.
First, hover over junctions marked bellow one-by-one and switch them to bends by using
Create Bend (SMBENDCREATE) tool.
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17. Next, go to the Ribbon under Sheet Metal in the Modify section and activate the Split
(SMFLANGESPLIT) tool.

Create four splits as shown below.

Alternatively in the V21 release of BricsCAD you can use “Smart Split Propagate”. When you place
one split, it will automatically detect any similar locations where this split can be applied.
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So after activating this tool, place the split in one of the corners as shown in the picture
above. Then it will automatically suggest other possible splits in similar corners. If all
splits are placed properly, press Enter to accept them.

Two bodies will appear in the Mechanical Browser.

18. Call Unfold for both bodies. Now nesting will be more optimal.
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Sheet metal form features
1. Create a new drawing: File-> New (QNEW).
2. Go to the Ribbon-> Home -> File and call Import (IMPORT) command.

3.

Import Sheet Metal Enclosure.SLDPRT file. If you do not have the Communicator installed you
can open the Step_1.dwg file and start from there.
When it is opened you can see that it is a basic 3D solid without BricsCAD Sheet Metal features, yet.
Because it is a thin walled solid we can easily convert it to sheet metal.

4. Go to the Ribbon under Sheet Metal in the Create section and activate the Convert (SMCONVERT)
command to recognize sheet metal features. You will see the colours change as it recognizes sheet
metal features.
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5. Examine the list of features in the Mechanical Browser. All form features are recognized,
but they are not parametric.
6. Locate a louver feature and hover over any face of it. Activate the Replace (SMREPLACE) command
from the Quad.

7. Choose the Louver.dwg form feature from the built-in library of parametric form features. The
command line will ask to replace all similar form features, select Yes.

8. All louvers will be replaced with parametric louvers. Size of the new louvers will be adapted to
match the previous size.
9. Repeat the same step for the four form features on the bottom face of the model. Use the
Emboss_with_hole.dwg form feature.
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10. Rotate the view to see the bottom face of the model and draw a line with a length of
150mm, similar to the picture below.

11. Go to the Ribbon under Sheet Metal in the Modify section and activate the Rib (SMRIB) tool or
hover over the line and use Quad button. It should generate a supporting rib feature.

12. Go to the Mechanical Browser, select Rib feature. Then change its parameters in the properties
panel. The exact dimensions are not important, just give it a try and see how it reacts to your input.
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13. Unfold the model, like we have done previously.

As you can see, even with imported models we can model and modify them as if they are native to
BricsCAD.
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Sheet metal assembly export
Before this exercise be sure to download the entire folder for this exercise.
1. Then open the turnstile def.dwg assembly file from your local 24/7 download path.

2. Observe the different components in the mechanical browser. This assembly consists of sheet
metal parts as well as standard solids.
3. Call the SMASSEMBLYEXPORT command in the command bar. In the dialogue select “Output
folder” and in the window that pops up, select the folder “OUT”, or create a new folder where it is
convenient for you. Then in the dialogue select “Entire model”.
4. Open the OUT folder and you can see the parts being exported and a report being made.
This command will search the assembly structure of this current drawing, for 3D solids and applies
the commands SMCONVERT and SMEXPORT2D to them. The information taken from these solids
and the output of the commands will be presented in a generated report. The report will indicate
the status of the parts and links to corresponding .dwg and .dxf files, as well as generated
thumbnails to easily visualize each part in the report.
5. Open the “turnstile def_report” located in the OUT folder, or any other output folder you might
have chosen. Find the “Top_assembly” in the report and notice how it says “Poor Sheet Metal”,
this means there is something wrong with this sheet metal part and we must fix it.
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6. Open the Top_assembly.dwg from the output folder. If you inspect the model you can
see that it does not have any bends or junctions, which makes it unable to unfold.

7. Convert it to sheet metal by going to Sheet Metal on the ribbon or by using the SMCONVERT
command.

8. Under the Sheet Metal tab click Bend and apply to the entire model.
9. Next in the same location on the ribbon, select Junction and apply it to the whole model. And then
select the edges of the large radii and apply Junction to them also, as seen below.
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10. Now the component should be fixed, so under the Sheet Metal tab select “Unfold Body”
and select a face on the body to start the unfolding. If it does not unfold, try selecting a
different face.

Now this sheet metal part is fixed. If we were to put this into the main assembly again we could
create a new export log and we would see that it is successfully classified as sheet metal with the
accompanying files and thumbnails, just like the other sheet metal parts.
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